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1 

Introduction 

Oracle Enterprise Transaction Controls Governor (ETCG) evaluates transaction risk 

in Oracle E-Business Suite and PeopleSoft. ETCG implements “models” and “contin-

uous controls” that specify circumstances under which individual transactions display 

evidence of error, fraud, or other risk. 

ETCG is one of a set of applications, known collectively as “Oracle Advanced Con-

trols,” that regulate activity in business applications. Together with another Advanced 

Controls application — Application Access Controls Governor — ETCG runs as a 

Continuous Control Monitoring (CCM) module in an Enterprise Governance, Risk 

and Compliance (GRC) platform. 

ETCG Models and Controls 

An ETCG model returns “temporary” results — a snapshot of risk that is replaced 

each time the model is evaluated. A continuous control returns “permanent” results 

— records of violations that remain available to be resolved no matter how often the 

control is run. 

Users create models, and then deploy controls based on those models; users cannot 

create controls directly. Although the creation of a model is a preliminary step in the 

creation of a control, models may be created to run on their own, so that users such 

as auditors can assess the risk inherent in a system at a given moment. 

An ETCG model or control specifies circumstances under which transactions pre-

sent risk and so require review. A model, or the control into which the model is con-

verted, consists of one or more filters — standard, function, or pattern. Each, in a 

distinct way, defines an aspect of the risk a transaction may present and captures 

records of transactions that meet its definition. 

Each of these elements may cite a “business object” and an “attribute” of that 

object, which supply transaction data for analysis. A business object is, in effect, a 

set of related data fields from an ERP application subject to GRC analysis, and an 

attribute is one field within the set.  

Filters may also cite other object types: A “custom” object is a set of data imported 

from an xml file. A “system-generated” object is data returned by certain transaction 

filters. A “user-defined” object is data returned by a specially configured continuous 

control; each of its result columns constitutes an attribute of the object.  
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There are two types of ETCG control or model: 

• A “Defined” control or model contains standard or function filters. These 

elements enable the user creating a model to define circumstances under which 

transactions are considered to pose a risk. A model or control can incorporate 

any number of standard or function filters. 

For example, a model may include two filters, both based on a Payables Invoice 

business object. One filter would select transactions for which an Invoice Can-

celed Date attribute is not blank. From the transactions captured by the first filter, 

the second would select those for which an Amount Paid attribute is not equal to 

zero. The model would therefore identify invoices on which payments had been 

made even though the invoices had been canceled. 

• A “Pattern” control or model contains a pattern — an Oracle-supplied statistical 

function that identifies a baseline set of transactions, then uncovers outliers to 

the baseline, as a way of discovering unknown risk. A control or model can use 

only one pattern (which can be combined with any number of filters or functions). 

Records of control violations are known as “incidents,” and each control names one 

or more GRC users as “result investigators” who are responsible for resolving incidents. 

Users may create perspectives, each of which is a set of hierarchically arranged val-

ues. Each represents a context in which models, continuous controls, and incidents 

exist. Users can relate individual perspective values to individual models, controls, 

or incidents, thus cataloging them by organization, region, or any other concept the 

company finds meaningful. Perspective values also play a part in GRC security. In 

particular, perspective values associated with controls or incidents determine which 

users are eligible to be result investigators — those assigned data roles with match-

ing perspective values. 

Incident Analysis 

Typically, continuous controls generate incidents when they are run (although spe-

cially configured controls may compile datasets for user-defined objects). Each 

ETCG incident provides a record of a transaction that exceeds the risk defined by a 

control. Each record is made up of values for attributes selected for the model that 

served as the basis for the control that generated the incident. 

Each incident identified by an ETCG control defaults to an Assigned status. This 

means that result investigators are assigned to address the incidents generated by a 

control. The investigator might: 

• Look at the incidents generated by a control, decide that nothing need be done 

to resolve them, and change status to Accepted. 

• Look at the incidents generated by a control, decide that something must be 

done in the business-management application to resolve them, and change status 

to Remediation. For an ETCG incident, remedial action typically involves deter-

mining whether a suspect transaction is in fact erroneous, fraudulent, or other-

wise damaging, and if so, correcting the situation. 

• In this second case, ensure that appropriate action has been taken in the business-

management application, and update status from Remediation to Resolved. 
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In addition to the Assigned, Accepted, Remediation, and Resolved statuses, GRC 

may automatically assign a Control Inactive status, which means that an incident is 

no longer of concern because the control that generated it has been inactivated.  

Each incident has not only status, but also one of three states: In Investigation, 

Approved, or Closed. These are assigned by GRC. See “Incident Status and State,” 

page 39. 

Reporting 

Users can run reports concerning ETCG, its companion applications, and GRC 

administration. Those that apply to ETCG include summary and detail reports about 

transaction controls and about the incidents they identify. 

Some reports can be run “contextually” — from pages in which controls are managed 

or incidents are resolved. Contextual reporting is discussed on pages 36 and 45 of this 

document. 

All reports can be run from Report Management pages. Because Report Management 

features are common to all GRC applications, they are discussed in the Enterprise 

Governance, Risk and Compliance User Guide.  

Common Procedures 

As you work with ETCG models, controls, and incidents, you may perform certain 

procedures that are common to GRC applications. You may use a home page or 

overview pages to view worklists (records of tasks requiring action on your part) and 

notifications (records of tasks in which you have an interest, but which do not require 

you to act). You may use navigation features to move among GRC application pages. 

You may use search features to filter lists of records. You may set “user preferences” 

— review and edit information about your user account. For complete information on 

these features, see the Enterprise Governance, Risk and Compliance User Guide. 

Descriptions of other common procedures follow. 

Selecting Perspectives 

You can assign perspective values to models, continuous controls, and incidents 

generated by controls. These may serve as filtering values in the management pages 

for these objects, or in reports. They also play a part in determining which users 

have access to any of these objects — those whose job roles contain data roles 

associated with perspective values that match the values selected for the object. 

(Users must also have duty roles granting privileges to work with the object.) 

Although perspective hierarchies are created in Perspective Management, each 

hierarchy becomes available for use with models, controls, or incidents only after 

being associated with that type of object in Manage Module Perspectives. In the pages 

for creating, editing, or resolving these objects, a Perspective Assignment panel dis-

plays a tab for each perspective hierarchy that has been associated with the object. 

In Manage Module Perspectives, a perspective may be designated as required for 

the object with which it is being associated. If so, the tab that displays its name also 
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displays an asterisk; a user is unable to save an instance of the object if he does not 

select a value for the required perspective. 

When you create or edit models, create controls or edit them individually, or edit 

incidents individually, you select a set of perspective values for the object with which 

you are working. When you “mass edit” controls or reassign a set of incidents, you 

select perspective values to be added to, or removed from, the values already selected 

for each of the objects with which you are working. 

To select perspective values: 

1. Click on the tab for the perspective hierarchy from which you want to select 

values. 

2. If you are editing two or more selected controls at once, or assigning two or 

more selected incidents simultaneously, select an Add or Remove radio button 

to indicate whether you are adding values to, or removing them from, values 

already selected for the objects with which you are working. (If you are creating 

objects or editing them individually, this step does not apply, and the radio 

buttons do not appear.) 

3. Choose values to move between Available Perspectives and Selected Perspec-

tives lists. (Ultimately, those in the Selected Perspectives list are assigned to 

individually configured objects, or added to or removed from those already 

assigned to mass-edited objects.) In either list, locate a perspective value you 

want to move from one list to the other. Do either of the following: 

• Click on the plus sign next to the root node to expose perspective values at 

the next hierarchical level. Click on a plus sign next to a node at that level 

to reveal its child nodes. Continue until you reach the node you want. 

• Type a text string in the search box to produce a list of matching 

perspective-value names. You can use the percent sign (%) as a wild-card 

character; entries are not case-sensitive. A search returns only matching 

perspective values; it does not display an entire perspective hierarchy. 

• For incidents only, select View > Expand All to display, and choose from, 

all nodes configured for the perspective. Other View options enable you to 

collapse the entire hierarchy, expand or collapse nodes beneath a selected 

node, display only a selected node and those that descend from it, and scroll 

to the first or last node.) 

If you are assigning perspective values to models or controls, you can choose 

them only one at a time; click on the value you want. If you are assigning per-

spective values to incidents, you may choose one value by clicking on it; choose 

a continuous set by clicking on the first, holding down the Shift key, and click-

ing on the last; or choose a discontinuous set by holding down the Ctrl key as 

you click on values. 

4. Click the > button to cause values chosen in the Available list to appear in the 

Selected list. Or, click the < button to remove values chosen in the Selected list 

from that list. 

(Alternatively, click the >> button to place all perspective values in the Selected 

list, or the << button to remove all values from that list.) 

5. Repeat steps 1–4 to select any number of perspective values from any number 

of hierarchies. 
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As you assign perspective values to incidents, you may also select a View Perspec-

tive button to see a representation of the full hierarchy from which you are selecting 

a value. Click on any value, and a Related Components panel opens, displaying ob-

jects with which the value is associated. (This feature is not available as you assign 

perspective values to models or controls.) 

Synchronizing Data 

Models and controls evaluate transactions completed in datasources (instances of 

business-management applications). It’s assumed that a set of datasources is configured 

for your ETCG instance. (See the Enterprise Governance, Risk and Compliance User 

Guide.) 

To ensure models and controls evaluate current data, run synchronization — a pro-

cess that copies data from datasources to ETCG. An ordinary synchronization run 

creates or updates only records that are new or have changed since the previous 

synchronization. 

Distinct processes synchronize transaction and access data. In most cases, you need 

synchronize only transaction data before evaluating transaction models or controls. In 

certain cases, however, you need to synchronize access data as well: If you intend to 

evaluate a transaction model or control that incorporates the User business object, or 

that contains filters that specify “who attributes” that return names. The latter identify 

users who complete actions in the target application, such as the Created By Name 

attribute of the Supplier business object. (“Who attributes” that return user IDs, how-

ever, do not require access synchronization.) 

ETCG distinguishes among three categories of business object — Transaction (in 

which records are created or updated frequently), and Operational and Configuration 

(consisting of master-data or setup records that change infrequently). If a Graph Syn-

chronization Date Limit is set, the synchronization of Transaction business objects 

operates only on records created or updated in datasources after a specified date. Older 

Transaction records remain as they were in the GRC database. (For Operational and 

Configuration business objects, however, a synchronization run encompasses all rec-

ords, regardless of when they were created or updated.) The Date Limit is specified 

in the Manage Application Configurations page; see the Enterprise Governance, Risk 

and Compliance User Guide.  

You have two synchronization options. One is to synchronize the data used only by 

an individual model (see “Model-Data Synchronization” on page 11).  

The other is to synchronize data supporting business objects used by all the models 

and controls configured to evaluate risk on a selected datasource. To use this option:  

1. Open a Manage Application Datasources page: select Setup and Administration 

under Tools in the Navigator, then Manage Application Datasources under Setup. 

2. Select the row for the datasource for which you want to synchronize data. 

3. Do one of the following: 

• Click on Actions > Synchronize Transaction. This causes ETCG data to be 

synchronized once, immediately. (Before you can synchronize transaction 

data, at least one transaction model must exist.) 
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• Click on Actions > Synchronize Access. This causes all access data to be 

synchronized once, immediately. (You can synchronize access data even if 

no models or controls yet exist.) 

• Click on Actions > Schedule Synchronize. A Schedule Parameter dialog 

opens; in it, you may create a schedule on which any number of synchroni-

zation operations run automatically. Select the Transaction or Access check 

box, or both, and enter values that set the name of the schedule, its start date 

and time, the regularity with which the synchronization should occur, and 

an end date (if any). Then click on the Schedule button. 

Rather than run an ordinary synchronization, you can instead “rebuild the graph” — 

delete all data for a given datasource and replace it with a complete set of current 

data. This typically takes longer than an ordinary synchronization, and it potentially 

has a significant effect on existing incidents, model results, and worklists. As a result, a 

graph rebuild should not be performed lightly. To rebuild the graph, open the Manage 

Application Datasources page and select the row for a datasource. Then select 

Actions > Rebuild Graph, and click the OK button in a confirmation message that 

appears. 

Attaching Files 

In the pages in which you create or edit incidents, you can attach files to them. An 

attachment may, for example, be a text file, spreadsheet, or web site that provides 

more information about an object than can be contained in its Description field. 

For most attachments, you need to specify a content type. These values are config-

ured in Manage Content Types, which is available in the Setup and Administration 

tasks. If no existing content type is appropriate for your attachment, have one cre-

ated in Manage Content Types. (See the Enterprise Governance, Risk and Compli-

ance User Guide.) 

To attach a file: 

1. Click on the green plus sign next to the Attachment label in a create or edit 

page. An Attachments pop-up opens. 

2. Select Actions > Add. A new row appears. 

3. Select a Type — desktop file or url. (During a mass update of incidents, only 

the url type can be attached.) 

4. If you select desktop file, click the browse button to navigate to, and select, the 

file you want. Select a content type, compose a title, and optionally enter a descrip-

tion. If you select url, enter it in the File Name/URL field, compose a title, and 

optionally enter a description. (Content type does not apply in this case.) 

5. If you wish to create additional attachments, repeat steps 2 through 4 for each 

attachment. 

6. Click the OK button to exist the Attachments pop-up. 

You can also delete an attachment by opening the Attachments pop-up, selecting a 

row, and selecting Actions > Delete. 

To view an attachment, click on its name in the management, creation, or edit page 

for an object. 
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Importing and Exporting Models and Controls 

You can export models and controls from a source instance to a file, or import them 

from a file to a destination instance. However, several rules apply: 

• “Seeded content” is a set of models (but not controls) developed by Oracle for 

use with GRC. A version of seeded content is released with each GA release of 

GRC. That version of seeded content can be imported into the GA release or 

any patch to that release. 

• Models and controls exported from an instance of a GA release can be imported 

into any patch for that release (but not from one patch to another, or one GA release 

to another).  

• Models and controls exported from a GRC instance at any particular version can 

be imported into another instance at the same version. 

To export models or controls: 

1. In the Manage page for models or controls, select items to export. To select one, 

click on it. To select a continuous set, click on the first, hold down the Shift key, 

and click on the last. To select a discontinuous set, hold the Ctrl key as you 

click on models or controls. 

2. Click on Actions > Export. An Information pop-up window opens, identifying a 

job number. Note the number, then close the window (click on its OK button). 

3. Using the Navigator, go to Tools > Setup and Administration > Manage Jobs. 

the Manage Jobs page, locate the row displaying the job ID you noted in step 2. 

When its Message cell displays a Job Completed link, click on the link. 

4. A Job Detail window opens. In it, click on the Item Results link. 

5. A file-download window offers you options to open or save the export file. The 

precise behavior of this window depends on the web browser you use, but in 

general, select the Save option and, in a distinct save-as dialog, navigate to the 

folder in which you want to save the file. The file is saved in .xml format. The 

first word of its name —Models or Controls — identifies its content. 

6. Close the Job Detail window (click on its OK button). 

Models and controls may specify perspective values, and upon import are available 

to users whose data roles are associated with those perspective values. (Before im-

porting, be sure the perspectives are set up in the target instance.)  

To import: 

1. Return to the Manage page for the item you are importing — models or 

controls. 

2. Click on Actions > Import. 

3. An Import File pop-up window opens. Click on its Browse button. 

4. A Choose File dialog opens. In it, navigate to, and select, the .xml file you want 

to import. The path and name of the file then populate the field next to the Browse 

button in the Import File window. 

5. Click on the OK button in the Import File window. 
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6. A Select Items to Import window lists the items contained in the import file. 

Select those you wish to import, bearing in mind that you can import only those 

items that use business objects to which your GRC roles grant you access. To 

select one item, click on it. To select a continuous set, click on the first item, 

hold down the Shift key, and click on the last. To select a discontinuous set, 

hold down the Ctrl key as you click on items. 

7. Click on the Next button. An Import Datasource Mapping window opens, dis-

playing one row for each datasource specified in the items you’ve chosen to im-

port. For each, in a Mapped Datasources list box, select a datasource appropri-

ate for the environment into which you are importing the models. (The list box 

displays datasources configured in the GRC Manage Application Datasources 

page, to which your GRC roles provide you access.) 

8. Click on the Import button. A pop-up message reports the number of items 

imported and the status of the import operation. Click on its × button to close it. 

A model or control may cite a user-defined object — data generated by a specially 

configured “dataset” control. Exporting a model or control that cites a user-defined 

object, and importing it to another instance, involves some special considerations: 

1. Export the dataset control (the one that generates data for the user-defined object) 

from the source instance. 

2. Export the model or control that cites the user-defined object. 

3. Import the dataset control into the destination instance, and manually run it 

there (see “Running Controls” on page 35) to generate an initial dataset. 

4. In the destination instance, manually create the user-defined object (see “Man-

aging User-Defined Objects” on page 37). Ensure that its name is identical to 

that of the user-defined object from the source instance. 

5. Import the model or control that cites the user-defined object into the 

destination instance. 
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2 

Creating and Managing Models 

A transaction model defines circumstances under which transactions might involve 

error or fraud, or otherwise present risk. It consists of filters that define aspects of 

risk and select records that satisfy their definitions. A combination of these filters 

defines a complete risk, with each filter evaluating records returned by filters that 

precede it. 

Each filter may cite business objects and attributes of those objects, which supply 

data for analysis. A business object is, in effect, a set of related data fields from a 

business application. An attribute is one field within the set.  

However, other object types are available to transaction models: A custom object is 

a set of data imported from an xml file. A system-generated object is data returned 

by certain transaction filters. A user-defined object is data returned by a specially 

configured continuous control. 

There are three transaction filter types: 

• Standard: A standard filter specifies an attribute of an object, and it selects 

records in which attribute values satisfy a condition. The condition consists of 

an action and elements that complete the action. Those elements may be one or 

more constant values, or another attribute of an object. 

For example, a filter may state that Payment Amount (an attribute of the Pay-

ment business object) is greater than $5,000 (a condition involving a constant 

value). 

Certain conditions enable a standard filter to gather attribute values into groups. 

For example, a filter that uses a Similar condition may find sets of invoices with 

similar vendor names, to identify duplicate invoices in which the vendor’s name 

is rendered slightly differently. 

• Function: A function filter, like a standard filter, creates a formula that specifies 

how attribute values must satisfy a condition. However, it also incorporates a 

function that operates on the attribute term, for example taking the average of a 

set of attribute values. It can establish groups of records on which the function 

operates, or it can use groups created by a standard filter. 

For example, a function filter might group records by supplier, calculate an aver-

age payment amount for each supplier, then determine whether each average 

amount exceeds a threshold value. 
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• Pattern: A pattern filter employs any in a set of statistical functions that identify 

baselines and outliers to those baselines. Each model can use only one pattern 

filter. 

For example, a Mean pattern calculates the mean for a set of numeric attribute 

values and identifies individual values too far above or below the mean. 

Managing Models 
A Manage Models page provides information about models to which your data roles 

give you access. Within that limitation, you can view and work with models created 

by any user — create or modify models, view or export results, or export and import 

models (page 7). To open the page, select Manage Transaction Models from among 

the Continuous Control Management tasks available from the Navigator.  

Viewing Models 

A Manage Transaction Models page includes a Manage Models grid, which dis-

plays a list of transaction models to which you have access. To open the page, select 

Manage Transaction Models in the Tasks list. 

The page displays summary information for each model it lists. This information is 

supplied by GRC, from data recorded when a model is created, edited, or run; you 

cannot update these records directly. 

Among the summary values, the model type may be Transaction—Defined, which 

means the model contains filters or functions. Or it may be Transaction—Pattern, 

which means the model contains a pattern, but may also contain filters or functions. 

(A third type, Access, applies to models created in Application Access Controls 

Governor.)  

Model status indicates whether the model has been evaluated and has produced results 

— records of transactions it has found to be risky. Values include Not Started, Started, 

Completed, and Canceled. In addition, an Error status links to the GRC Jobs page, 

which can provide information about processing errors. Model state is either Approved 

or Invalid (the latter state applying only to models that are not imported correctly 

during an upgrade from an earlier version).  

Creating, Editing, Copying, or Deleting Models 

To create a model, select a Create Transaction Model option, which is available 

both in the Actions menu of the Manage Transaction Models and among the Con-

tinuous Control Management tasks available from the Navigator. Either selection opens 

a Create Transaction Model page (see “Creating an Transaction Model,” page 11). 

To edit a model, click in the Manage Models grid on the row for the transaction 

model you want to edit. Then click on Actions > Edit. This opens an Edit Transac-

tion Model page — a replica of a model-creation page, except that it is populated by 

values for the model you want to edit. 

Rather than create a model from scratch, you can copy an existing model, then mod-

ify the copy. To do so, select (click on) the model you want to copy. Then select 

Actions > Copy. A new row appears in the Manage Models grid, identical to the 
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listing for the copied model except that the model name ends in a number in paren-

theses. (The value of the number depends on how often you copy the original.) Once 

the copy exists, you can select Actions > Edit to modify the model as you please. 

To delete a model, click in the Manage Models grid on the row for the model you 

want to delete. Then click on Actions > Delete, and respond to a message that asks 

you to confirm the deletion. 

Model-Data Synchronization 

From the Manage Transaction Models page, you can select a model and synchronize 

the data it uses. This process loads data only for business objects that are used by the 

selected model and have never been synchronized before. So this synchronization 

option enables you to add new objects as you create or edit a model, and then load 

the data you need to test that model.  

1. In the Manage Models grid, select the row for a model whose data you want to 

update. 

2. Select Actions > Synchronize. 

3. A message displays a job number; note the number, then close the message 

(click on its OK button).  

4. To check on the status of the synchronization job, navigate to Tools > Setup and 

Administration > Manage Jobs. In the Manage Jobs page, locate the row display-

ing the job ID you noted in step 3. Click on the link in its Message cell.  

From a Manage Application Datasources page, you can instead synchronize all 

transaction data from a datasource at once. See “Synchronizing Data” on page 5.  

Creating a Transaction Model 

To create a transaction model: 

1. Open the Create Transaction Model page: Click on Actions > Create Transac-

tion Model in the Manage Transaction Models page (see page 10). Or, select 

Create Transaction Model under Control Management in the Tasks panel.  

2. Name and describe the model. If an analysis time limit has been set, choose 

whether to accept or disable it for this model (page 12). 

3. Select business objects (page 12) and datasources (page 15) which, in combina-

tion, determine the data available for a model to evaluate. You may use custom 

objects (page 14), system-generated objects (the results of filters that generate 

sets of values; page 18), or user-defined objects (the results of specially 

configured controls; page 36) as if they were business objects. 

4. Create standard or function filters, or a pattern filter. As you create them, 

arrange their vertical and horizontal alignment to one another, to set the order in 

which they are to be evaluated (pages 16–26). 

5. Select perspective values for the model (page 3). 

Each model is automatically assigned values for certain system perspectives: 

CCM Type, Business Object, Datasource, and potentially User Defined Busi-

ness Object. These values represent selections you make as you create the 



 

12 Oracle Enterprise Transaction Controls Governor User Guide 

model — whether it is an access or transaction model, and the datasources and 

objects you select for it. So at minimum, a model is restricted to users whose 

data roles include matching values for system perspectives. You can assign 

other perspective values, further restricting the model’s availability. Perspective 

values associated with a model also apply to any control developed from the 

model. 

6. Define model results (page 26), and save the model (page 27). 

Naming the Model 

Near the top of the Create Transaction Model page, locate the Name field. Click in 

it, and type a name for your model. Then click in the Description field immediately 

below the Name field, and enter a brief explanation of the purpose for the model. 

Alongside the Name field, a Datasource field displays the datasources that are 

subject to the model you create. Initially, the field may display a default datasource 

(if one is specified in the Manage Application Data page). You can add datasources 

to the model, or delete datasources (including the default datasource), but you do so 

elsewhere. GRC updates the Datasource field, and you cannot do so directly. 

Choosing Whether to Limit Analysis Time 

An Enforce Allocated Analysis Time Per Filter feature may be enabled in the 

Properties tab of the Manage Application Configurations page. (See the Enterprise 

Governance, Risk and Compliance User Guide.) If so, an Allocated Analysis Time 

Per Filter checkbox is selected by default in the Create Transaction Model page. You 

can disable this feature for the model you are creating by clearing the check box.  

When this feature is active, each filter you create for the model runs for no longer than 

a number of minutes displayed in the checkbox label. If time expires, the filter 

passes records it has selected to the next filter for analysis, but ignores records it has 

not yet examined. In this case, the filter may not capture every transaction that meets 

its definition, and the results returned by the model are labeled “partial” in GRC 

job-management pages.  

When the Allocated Analysis Time feature is disabled, each filter evaluates all appro-

priate records, no matter how long that takes.  

The number of minutes per filter is set in the Properties tab of the Manage Applica-

tion Configurations page. You cannot change it in the Create Transaction Model page. 

Moreover, if the feature is not enabled in the Properties tab of the Manage Applica-

tion Configurations page, the Analysis Time checkbox on the Create Transaction 

Model page is cleared by default, and you cannot select it. 

Selecting Business Objects 

Select one or more business objects. Each is a set of related transaction, master-data, 

or setup data fields, and an attribute is one field within the set. A model filter deter-

mines whether values for an attribute of the object present some risk. In place of a 

business object, you may select a custom object (page 14), system-generated object 

(page 18), or user-defined object (page 36). 
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To add business objects to a model: 

1. In a grid at the left of the Create Transaction Model page, select (click on) the 

Business Objects tab, and then on an object in the grid. (Although unlabeled, 

this grid is known as “the Library.”) 

2. Do either of the following: 

• In the Library, click on the Add to Model button. The selected business 

object appears in the panel labeled “Model Objects.” 

• Use your mouse to drag the business object to the area labeled “Add Object 

Here” in the Model Objects panel. 

3. Repeat this process if you wish to add more objects to the model. 

Within the Model Objects panel, each business object appears as a window in which 

you can view, but not actually select, the attributes of the object. You can also: 

• View the synchronization cutoff date, if a Graph Synchronization Date Limit is 

set (see “Synchronizing Data” on page 5). To do so, place the mouse cursor over 

the title bar for a Transaction business object. If no Graph Synchronization Date 

Limit is specified, the value No Date Limit appears. That value also appears if 

you place the mouse cursor over the title bar for an Operational or Configura-

tion business object, regardless of whether a Graph Synchronization Date Limit 

is specified. 

• Remove a business object from the model: click on its × button. 

• Move a business object to the left or right of other objects: Click on the 

downward-pointing, green triangle. Two options appear; click on either Move 

Left or Move Right. 

• Create custom attributes. Each specifies an existing attribute and combines its 

values with a fixed value or with the values for another attribute.  

1. Click on the green + icon. An Add Custom Attribute dialog opens. 

2. In an Attribute Name field, create a name for the new attribute. 

3. In a Base Attribute field, select one of the existing attributes. 

4. In a Modifier field, select a mathematical operator: + (addition),  

– (subtraction), * (multiplication), / (division), or & (creates a comma-

delimited text string of the combined values). You are able to select only 

among modifiers appropriate for the base attribute selected in step 3. For 

example, you can subtract dates, but you cannot multiply them. 

5. In a Type field, select Value or Object. 

6. If you selected Value, enter a value to be combined with the base attribute, 

as defined by the modifier. 

If you selected Object, select a second attribute, whose values are combined 

with those of the base attribute, as defined by the modifier. 

7. Click on the OK button. 

You can use the custom attribute in filters. Custom attributes appear at the top 

of the list of attributes displayed by the business object, and each has an edit 
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icon (which looks like a pencil). You can click on a custom attribute to open 

another dialog box in which you may either edit or delete the custom attribute. 

Using Custom Objects 

You can import any set of data as a custom object, and use it as if it were a business 

object.  

Formatting 

You can import xml files or zip archives of xml files. The maximum import-file size 

is 2 gigabytes. As you create an xml file, observe the following formatting conven-

tions: 

• The first row of the file contains column headers. Each consists of a name and, 

in parentheses, a data type. Examples are NAME(String), IDNUMBER(Integer), 

DATE(Date), or AMOUNT(Double). Each header name is an attribute of the 

object. 

• All remaining rows contain attribute values. 

• The file must contain only one sheet. 

• Make the following formatting conversions: 

– Convert all computed values to absolute values. 

– Remove any total-amount rows not directly tied to specific data attributes. 

– Remove numeric formatting (such as dollar signs). Change the format to 

Number format. 

– Format negative amounts to use a negative sign, not parentheses. 

– Use the mm/dd/yyyy date format. 

– Excel 2003 and later are supported. You can format an xls file properly, 

then save it as an xml file. 

If you refresh an existing custom object, the new file must use the exact format of the 

original. You can neither add nor delete columns. You can only add rows of values. 

Custom Dictionary for the Expresses Condition 

A filter may contain an Expresses condition, which determines whether text fields in 

a specified business or custom object contain any term in a custom dictionary. For 

this condition to be used, the dictionary must be created as a custom object.  

• At minimum, the object must contain a Word attribute (String format) and a 

Relevance attribute (Double format). The Word attribute lists terms for which 

the Expresses condition searches. The Relevance attribute rates their relative 

importance. You may include other attributes. Along with the Relevance attrib-

ute, these may be selected for the results displayed for incidents generated by a 

model or control that uses the Expresses condition.  

• An Include Empty Row advanced option is available to the Expresses condition. 

For it to be useful, include one row in the custom object in which the Word value 

is null and the Relevance value is 0.  
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Uploading an Object 

To upload a custom object: 

1. Click on Custom Objects > Import in the Library for the Create Transaction 

Model page. An Import File dialog opens. 

2. Create a name for the object in the Name field. This is the object name the 

Library will display. 

3. In a Type field, select a label that characterizes the content of the custom object 

— for example, Financials or Procurement. 

4. Click the Browse button. A Choose File dialog opens. In it, navigate to, and 

select, the xml or zip file you want to import. The path and name of the file 

populate the field next to the Browse button in the Import File window. 

5. With the file selected, click on the OK button. The custom object is now 

available for use as if it were a standard business object. 

To delete a custom object, select it in the Library. Then select Custom Objects > 

Delete, and respond to a prompt to confirm your deletion. 

Selecting Datasources 

Before a business (or other) object can supply transaction data to a model, it must be 

associated with at least one datasource. As the model is evaluated, a filter citing that 

business object will analyze data from the associated datasource.  

• For most objects, the datasource is an instance of a business application subject 

to analysis by the model. Connections to these datasources are configured in the 

Manage Application Datasources page. 

• For either of two business objects — User or Access Entitlements — or for a 

user-defined object, the datasource is Grc. This corresponds to the GRC instance 

in which you're working. 

• For a custom object, the datasource is XLS. 

In the Manage Application Datasources page, one datasource may be designated as 

default. If so, that datasource is associated with any business object (other than User 

or Access Entitlement) as soon as you select it for a model. No matter whether a 

default datasource has been configured, you must actively select the Grc datasource 

for the User or Access Entitlements business object, or for any user-defined object. 

As you add business objects to a model, you can change, or add to, their default data-

source selection. If no default datasource has been designated, you can add datasources 

to each business object: 

1. When you add a business object to the Model Objects panel, a Manage Data-

source button becomes active. Click on it. A Manage Datasource window opens.  

2. To add a datasource, create a new row: click on Actions > Create New, or on 

the green + sign. (You can have multiple rows for each business object.) To 

change a datasource selection already made for an object, work in its existing 

row. 

3. If you’re adding a datasource, click in the Business Object field of a new row 

and select the Business Object for which you want to add a source. If you’re 
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modifying an existing datasource, locate the row in which the Business Object 

field displays the name of the object whose source you want to change. 

4. Click in the Datasource Name field, which lists datasources configured in the 

Manage Application Data page. Click on the datasource you want to associate 

with the business object. Other fields are populated automatically. 

If you selected the User or Access Entitlement business object in step 3, associ-

ate it with a Grc datasource (which exists automatically). For any other business 

object, select a datasource for an instance of a business-management application 

in which a model is to be run. (These are configured in the Manage Application 

Datasource page.) 

5. Click on the Save and Close button. If you’ve added datasources, their names 

appear in the Datasource field (alongside the Name field near the top of the 

Create Transaction Model page.) 

You can also delete the association of a datasource with a business object. While the 

Manage Datasources window is open, select (click on) the row for the association 

you want to delete. Click on Actions > Delete or on the red × icon. 

Arranging Filters, Functions, and Patterns 

As you add filters to a model, position each vertically or horizontally with respect to 

others to determine the order in which they are processed: 

• A vertical arrangement indicates an AND relationship: Filters at one level are 

evaluated before those at the level below it, the topmost first and the bottommost 

last. Presuming that processing at any vertical level returns records, processing 

continues on those records at the next level. For the model to return any results, 

every vertical level must evaluate to true (filters at every level must identify 

transactions). A pattern can form only an AND relationship with other filters. 

• Standard and function filters, however, may be positioned horizontally to one 

another. This indicates an OR relationship — if any one filter or function within a 

horizontal set returns results, processing moves to the next vertical level. 

To add the first filter to a model, click on a button (or a corresponding option in the 

Actions menu) that selects the type you want — New Filter, New Function, or New 

Pattern. To add subsequent filters, click again on any of those buttons (or menu 

options). As you do, keep these concepts in mind: 

• When you add a filter, it appears by default below the lowest filter in your 

model hierarchy. If, for example, a model contains three vertical levels and you 

add a filter, it appears at the fourth vertical level. Arrows connect one level to 

the next, indicating the flow in which filters are to be evaluated. 

• You can drag and drop existing filters to new positions within the model. Move 

the mouse cursor to the upper middle of the filter you want to move. Left-click, 

hold the mouse button down, and do either of the following: 

– To create an OR (horizontal) relationship, drag a filter so that it overlays any 

other filter. To add any number of filters to the OR relationship, drag each 

new filter on top of any filter currently in the OR relationship. 
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– To rearrange or create an AND (vertical) relationship, drag any filter (even 

one from within an OR relationship) to one of the arrowheads that demarcate 

the levels of your model hierarchy. You cannot drag a filter above the top 

filter in your model hierarchy, but you can drag that top filter below any 

other. 

• Once two or more filters exist in your model, you can select them: hold down 

the Ctrl key and click in the upper middle of each filter you want to select. 

When you select a filter, it is enclosed in a box made of dashed lines. If you 

select multiple filters, ensure they are adjacent to one another. To deselect a 

filter, hold the Ctrl key and click on the filter again; the dashed lines disappear. 

• You can incorporate filters into groups: select those you want to include and 

click on the Group Filters button (or on Actions > Group Filters). You can drag 

and drop groups in the same ways as individual filters. To dissolve a group, 

select it and click the Ungroup Filter button (or Actions > Ungroup Filter). 

• A transaction model should not contain more than one pattern.  

Create structures as complex as you like. For example, an OR statement may contain 

any number of filters. 

Or, a filter may have an AND or OR relationship with blocks of other filters. For example, 

suppose filters One, Two, and Three are in an AND relationship — stacked vertically. 

You could drag Three into a horizontal pairing with Two; One would remain centered 

above them. The model would return results if One returned results and then either of 

Two or Three returned results. 

For another example, suppose filters One, Two, Three, and Four are stacked verti-

cally. You can select One and Two and enclose them in a group, select Three and 

Four and enclose them in a group, and then drag the Three and Four group into a 

horizontal pairing with the One and Two group. The model would return results if 

transactions were captured by filters One and Two, or by filters Three and Four.  

Creating a Standard Filter 

To create a standard transaction filter:  

1. Click on the New Filter button, or on Actions > New Filter. A dialog box 

appears in the Model Logic panel. Enter a name for the filter in the Filter field. 

2. An Object field lists all of the business (or custom, system-generated, or user-

defined ) objects you’ve added to the model in the Model Objects panel. Select 

(click on) the one from which you want to select an attribute for use in this 

filter. Then select that attribute in the Attribute field 

3. Select a condition and values that complete the condition. For example, if you 

have selected the Payment Amount attribute of the Payment business object, 

you might select an “is greater than” condition and fixed numeric value, to 

select records in which payment amounts exceed that value. See “Model Filter 

Conditions” (page 19). 

4. Optionally, click on the ± toggle next to the Advanced Options label, and select 

advanced options. See “Advanced Options for Model Filters” (page 21). 



 

18 Oracle Enterprise Transaction Controls Governor User Guide 

Creating a Function Filter 

A function applies a calculation to groups of attribute values, then determines 

whether each calculated value poses a risk. The function must recognize groups of 

records to which it applies the calculation. 

The function can group records on its own. Or, a standard filter can create a system-

generated object (page 23), and the function can use the groups defined for that 

object. If a standard filter is to define groups, create it first, then create the function 

filter in an AND relationship with (below) the standard filter. 

To create a function: 

1. Click on the New Function button, or on Actions > New Function. A dialog box 

appears in the Model Logic panel. Enter a name in its Function field. 

2. In a line labeled Filter, use Object and Attribute fields to gather records into 

groups. Do either of the following: 

• If the function is to create groups on its own, select a business object in the 

Object field and one of its attributes in the Attribute field. In each group the 

function creates, values for that attribute match exactly. 

• If the function is to use a system-generated object, select the name of that 

object in the Object field, and one of its attributes in the Attribute field. This 

creates subgroups: records in each group defined by the system-generated 

object are sorted further on the values of the attribute you select. (In this 

case, the setting of a Generate Subgroups advanced option may determine 

how the function filter uses these groups and subgroups to report results.) 

3. In a line labeled When, use a Function field to select the calculation that is to be 

performed on grouped attribute values. Select among: 

• Average: Calculates the average of the attribute values. 

• Count: Determines how many attribute values exist. 

• Sum: Adds the attribute values together. 

• Rank: Arranges attribute values in ascending order. (A Display in Descend-

ing Order advanced option may reverse this order.) 

• Exclusive: Determines whether all in a set of semicolon-delimited text strings 

are included in records for each group. (You can find out whether expense 

reports contain conflicting values, for example gasoline purchases and taxi 

expenses.) 

• Inclusive: Determines whether one or more, but not all, of a set of 

semicolon-delimited text strings are included in records for each group. 

(You can find out whether expense reports do not contain complementary 

values, for example rental car but no gasoline purchases.) 

4. For any function other than Count, use Object and Attribute fields in the When 

line to select the attribute upon which the function is to perform calculations.. 

The Count function operates on the attribute you selected (in the Filter line) to 

group records. It removes the option to select another object and attribute. 
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5. In the remaining fields of the When line, select a condition and values that 

complete the condition. (See “Model Filter Conditions,” page 19.) For the Rank 

and Count functions, the value must be a positive integer. 

Note for the Rank function: The condition and value specify one or more ranks, 

and the filter returns records at those ranks. For example, Equals 4 returns one 

record for each group, containing the fourth-ranking value of the attribute. Or, 

Less Than 4 returns three records for each group, containing the first- through 

third-ranking values. 

6. Optionally, open the Advanced Options section and select options that refine the 

attribute-condition formula you have created. (See “Advanced Options for Model 

Filters,” page 21.) 

An example: Group payables invoices by supplier, calculate the average payment to 

each supplier, and find average amounts that exceed a threshold. 

• To group records, use the Filter line to select the Payables Invoice object and 

Supplier ID attribute. 

• To evaluate grouped records, use the When line to select the Average function, 

the Payables Invoice object, the Invoice Amount attribute, the greater than con-

dition, and whatever value you choose as a threshold. 

A second example: Group payables invoices by supplier, and identify the suppliers 

for which the number of invoices exceeds a threshold. 

• To group records, use the Filter line to select the Payables Invoice object and 

Supplier ID attribute. 

• To evaluate the grouped records, use the When line to select the Count function. 

The dialog refreshes so that the Object and Attribute fields disappear. Select the 

greater than condition and whatever value you choose as a threshold. These 

selections apply to the Supplier ID attribute. 

Model Filter Conditions 

A model filter specifies an attribute of an object, then selects records in which 

attribute values satisfy a condition. You select the condition and elements that 

complete it: one or more constant values, or another attribute of an object.  

For example, this is a filter that uses a condition involving a constant value: the 

Payment Amount attribute of the Payment business object is greater than $5,000. 

You can select among the following conditions, although those available to you 

depend on the attribute you select for a filter: 

• Mathematical operators: The filter returns results if the value of one attribute 

equals, does not equal, is less than, is less than or equal to, is greater than, or is 

greater than or equal to either a constant value or another attribute value. For a 

date attribute, “less” means “earlier,” and “greater” means “later.”  

You can set an attribute of a business object equal to itself. The filter returns 

groups of records. In each group, the attribute equals a specific value. If the 

attribute were Supplier ID, for example, all records for supplier ID 1234 would 

form one group, all records for ID 2345 would form another group, and so on. 
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• Contains and Does Not Contain: A Contains filter returns results if the value of 

an attribute is a text string that includes a specified text string. To the right of 

the Contains condition, you may specify a constant value, or you may specify 

another attribute, whose values may be contained within those of the attribute to 

the left of the Contains condition.  

A Does Not Contain filter returns results if the value of an attribute is a text 

string that does not include a specified text string. In effect, it returns all records 

that a Contains filter would not.  

• In and Not In: The filter returns results if the value of an attribute is a text string 

that matches, or does not match, any in a specified set of values. You may spe-

cify only constant, text-string values, delimited by semicolons. The match must 

be exact.  

• Between: The filter returns results if the value of an attribute falls between two 

constant values that you select.  

• Is Blank and Is Not Blank: The filter returns records for which an attribute 

either has no value, or has any value. The filter consists only of the attribute and 

the Is Blank or Is Not Blank statement, because these two elements are 

sufficient to define the filter.  

• Starts With and Ends With: The filter returns results if the value of an attribute 

begins or concludes with a specified string of alphabetic or numeric characters. 

You may specify a constant value or another attribute that returns text values.  

• Is Not Related To: Identify items that should, but do not, have links to other 

items. For example, invoices should have references to purchase orders, and a 

filter using this condition would return records of those that don’t. To the left 

and right of the Is Not Related To condition, specify the attributes that should 

be related. 

• Similar and Similar To: Use the Similar condition to check for similarity in the 

values of one attribute. Similar To checks for similarity in two attributes; a value 

of either may be similar to other values of the same attribute or to values of the 

other attribute. 

For either condition, define a standard of similarity. The filter then collects 

records into groups. In each group, attribute values meet your standard in a 

distinct way.  

– Text: Enter a percentage. Strings are similar if the number of characters 

they share is at least that percentage of total characters. For example, six-

character strings are 50 percent similar if they contain three matching 

characters. 

Values with distinct sets of matching characters form distinct groups. For 

example, one group might contain strings with blt, and another strings with 

pbj. 

Characters in one string need not be consecutive to match characters in 

another string. By default, the filter checks whether entire strings are sim-

ilar. You can select a Similar Word advanced option to check for similarity 

in any single word in each string.  
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– Number: Enter a percentage. This sets a lower limit. An upper limit is the 

same number of points above 100 percent as your percentage is below. For 

example, if you enter 85 percent, you establish two limiting values, 0.85 

and 1.15. 

The filter takes the average of numbers already included in a group, multi-

plies it by the limiting values to create a range, and admits a new value if it 

falls within the range. Each time a new value is added, the group average 

changes, and so does the range for admitting new values. 

In the 85 percent example, one group may include the values 22 and 20, 

while another includes the values 9 and 8. However, although 7 is one apart 

from 8, just as 8 is from 9, 7 is not similar to 9 and 8. That’s because the 

average of 9 and 8 is 8.5, and the 85 percent range around 8.5 is 7.225 to 

9.775. 

– Date: Enter a number of days. Dates are similar if they fall within this span. 

By default, a record belongs only to the group for which it qualifies first. (Text 

strings are evaluated in ascending alphabetic order; numeric values in descend-

ing numeric order.) You can set a Generate Results for Similar Groups advanced 

option to have records belong to all groups they qualify for. 

The filter excludes records that don’t qualify for any of the groups it creates. 

You can select an Include Unique Data Rows advanced option to get records the 

filter would otherwise exclude. 

• Different Than: Uncover records with dissimilar values for two specified 

attributes. Again, similarity is measured in percentage or, for dates, number of 

days. The values of each attribute are compared not only with themselves, but 

also with the values of the other. In effect, Different Than would return the 

records that Similar To would not return. 

• Expresses: Find records in which the value of an attribute is a text string 

containing any term in a dictionary, which must exist as a custom object (see 

“Using Custom Objects,” page 14). Supply the name of that custom object in 

the Object field to the right of the Expresses condition, and Word in the 

Attribute field. 

• Related To: Establish a join relationship between an attribute of a user-defined 

object and an attribute of a business, custom, or user-defined object. Specify the 

UDO attribute to the left of the Related To condition, and the attribute of the 

other object to the right. 

This join relationship is valid only for the model or control it exists in. A user-

defined object can have only one dynamic join relationship per model. 

Advanced Options for Model Filters 

You may be able to set advanced options that refine a filter’s basic formula. The 

availability of each option depends on the type of filter you are creating and the 

attribute or condition you select for the filter.  
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The following options may be used in standard or function filters:  

• Exclude: Clear it to get records that satisfy a filter’s attribute-condition formula. 

Select it to exclude those records and get all others.  

• Partial Match: Filters may generate “parent” and “child” sets of records. This 

option determines how parent values are matched to child values, and so what 

records are returned as model results. For more detail, see “System-Generated 

Objects: Explained” (page 23). 

The following options are available if you use the Similar or Similar To condition in 

a standard filter:  

• Include Unique Data Rows: Clear to exclude records that do not qualify for any 

group the filter creates. Select to have the filter return the groups it would ordi-

narily return, plus the records it would otherwise exclude.  

• Generate Results for Similar Groups: Clear to include a given record only in the 

first group it qualifies for. Select to include each record in all groups it qualifies 

for.  

• Similar Word: Clear to require full text strings to meet the similarity threshold 

established by the filter. Select to allow any word in one string to be similar to 

any word in another.  

• Apply Condition Across the Same Data Row: This option applies only to a 

Similar To filter that specifies two attributes belonging to a single business 

object. Clear to compare values across all rows of the object, so that a given 

attribute value may be similar to values of either attribute. Select to consider 

each row individually, so that a value of one attribute can be similar only to a 

value of the other attribute. 

The following options are also available to standard filters:  

• Include Empty Row: This option applies to the Expresses condition. Clear to get 

only records that include terms in a custom dictionary. Select to have all records 

returned; those without dictionary terms have a relevance of 0. Use this option 

only if the dictionary (a custom object) includes a row in which a Word attribute 

is null and a Relevance attribute is 0. 

• Match Case: In searches for matching text values, clear to ignore capitalization 

or select to consider capitalization.  

• Ignore Leading and Trailing Spaces: Clear to consider, or select to ignore, 

leading and trailing spaces in searches for matching text values.  

• Ignore After Floating Point: Clear to consider, or select to ignore, digits after a 

decimal point in number values. For example, if this option were selected, a 

filter specifying “Payment Amount ends with 5” would return the value 25.67.  

• Enable Synonyms: Select to apply a basic thesaurus lookup for matches in text 

values, or clear to require precise matches. If this option were selected for a 

“Supplier Name contains company” filter, for example, it would return records 

in which the supplier name contains the words corporation and firm as well.  
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• Include Time with Date: Clear to ignore, or select to consider, time while you 

look for matches in date values. If you select this option, you may use:  

– Apply Range of Time to find matches for records that fall within a time 

range you define.  

– Apply Day of Week to find matches for records worked only on days you 

select.  

The following options are available to function transaction filters:  

• Generate Subgroups: This option applies when a function uses groups created 

by a system-generated object, and typically when the Count function is selected. 

Clear it to count the number of subgroups that belong to each group. Select it to 

count either of the following:  

– The number of records in each subgroup, if the attribute in the Filter line is 

also selected as a result attribute.  

– The number of records in each parent group, if the attribute in the Filter line 

is not a result attribute.  

• Over Interval: This option applies when a function organizes groups by date. 

Clear it to have each group contain records generated on a distinct date. Select it 

to have each group contain records whose dates fall within a time period. You 

define the period:  

– Specify Overlap to define overlapping periods. For example, two-day 

periods may include Monday and Tuesday, then Tuesday and Wednesday, 

then Wednesday and Thursday.  

– Specify Successive to define distinct periods. In the two-day-period 

example, periods might be Monday and Tuesday, then Wednesday and 

Thursday, then Friday and Saturday.  

– Having selected Overlap or Successive, select a number of days, weeks, or 

months, then set start and end dates.  

• Display in Descending Order: This option applies to the Rank function. Clear it 

to rank values in ascending order. Select it to rank values in descending order. 

System-Generated Objects: Explained 

In transaction models (and controls), a filter that uses the Equals, Similar, or Similar 

To condition may return values separated into groups. (See “Model Filter Conditions,” 

page 19.) The records returned by such a filter serve as a “system-generated object,” 

which means they may be used in subsequent filters as if they were a business object.  

Naming Conventions 

A system-generated object is named Condition[Object.Attribute], in which 

Condition is the name of the condition used in the filter, and Object and Attribute 

are replaced by the names of the business object and attribute cited in the filter. For 

example, “Equals[Payables Invoice.Invoice Number].” 

Multiple Equals, Similar, or Similar To filters, joined in an AND relationship, may 

produce a system-generated object with more narrowly defined groups of records. 

The name for such an object identifies all the business objects and attributes it uses, 

for example Condition[Object1.Attribute1 AND Object2.Attribute2]. 
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Use Cases  

In one common usage, a filter produces a system-generated object. A subsequent 

filter cites that object, so that it can apply a function to each group of records de-

fined by the object. (See “Creating a Function Filter,” page 18.) 

In another common usage, one filter uses the Equals condition to create a system-

generated object. A second filter uses the Does Not Equal condition to identify dis-

crepancies within each group created by the system-generated object. For example:  

• A filter states that the Invoice Number attribute of the Payables Invoice business 

object equals itself. The resulting object — Equals[Payables Invoice.Invoice 

Number] — contains sets of records. In each set, all records have the same in-

voice number.  

• A second filter states that the Supplier ID attribute of the Equals[Payables 

Invoice.Invoice Number] object does not equal itself. This identifies distinct 

suppliers in each set. The overall result is records of distinct suppliers who have 

been issued duplicate invoice numbers. 

(As an alternative, the filter that creates the system-generated object may use the 

Similar condition or the Similar To condition. If so, the filter that identifies discrep-

ancies within groups would use the Different Than condition.) 

Limitations 

You cannot create a filter specifying that an attribute of a business object does not 

equal itself. A filter can, however, state that an attribute of a system-generated 

object does not equal itself. 

Similarly, you cannot use the Different Than condition to create a filter stating that 

an attribute of a business object differs from itself. You can, however, create a filter 

stating that an attribute of a system-generated object differs from itself, if that object 

is created by a Similar or Similar To filter. 

Parent and Child Sets of Records 

You can create a model in which one or more filters generate “parent” sets of 

records, and a second one or more filters generate distinct “child” sets of records 

that have an attribute in common with the parent sets. The model matches values in 

the parent “set of sets” with those in the child “set of sets” to determine which sets 

are included among model results and which are discarded. For example: 

• Create two filters that use attributes of the Payables Invoice business object. In 

the first, the Invoice Number attribute equals itself; in the second, the Invoice 

Amount attribute equals itself. The result is a system-generated object called 

Equals[Payables Invoice.Invoice Number AND Payables Invoice.Invoice 

Amount]. It contains groups of invoices, in each of which all invoices have the 

same number and same amount. 

• Create a third filter specifying that the Supplier ID of that system-generated 

object does not equal itself. The result is parent sets of invoices, in each of 

which invoice number and amount are the same, but at least one supplier ID 

differs from the others. (If all supplier IDs are the same within a set, that set is 

discarded.) 

• Create a fourth filter that equates the Taxpayer ID attribute of the Supplier 

business object with itself. Its result is a new, child set of sets. In each set, the 
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taxpayer ID is the same for all records, but it may correlate to any number of 

supplier IDs. The model would compare parent and child sets, and keep only 

those parent sets in which it finds matching values. 

A Partial Match advanced option determines how this matching is done. You select 

or clear the Partial Match check box in the filter that defines the child sets.  

• If this check box is cleared (the default), all values for the common attribute in a 

parent set must match values in at least one child set.  

• If this check box is selected, only one value for the common attribute in a parent 

set need match a value in a child set. 

In the example, the common attribute is Supplier ID. If the Partial Match check box 

is cleared, then every supplier ID in a given parent set must appear in one of the 

child sets for the parent set to be kept among the model results. If not, the entire 

parent set is discarded. 

However if the Partial Match check box is selected, and any one supplier ID in a 

given parent set appears in one of the child sets, the entire parent set is kept among 

model results. If no supplier ID in a parent set matches an ID in a child set, the 

entire parent set is discarded. 

Creating a Pattern Filter 

You can add one pattern to a given model (and the addition of that pattern classifies 

the model as the pattern type, even if it contains defined filters). Each pattern calcu-

lates a baseline value and identifies transactions that vary excessively from the base-

line; each takes parameters, which enable you to define the variance that is con-

sidered excessive. 

• Benford: Benford’s Law states that even in widely varied sets of numeric data, 

the frequency distribution of leading digits is predictable. For example, approx-

imately 30 percent of values begin with the digit 1 (if values are expressed in base 

10). This pattern compares the distribution of leading digits in sets of numbers 

with the distribution predicted by Benford’s Law, and identifies discrepancies. 

To define the data sets, specify one or more attributes that return number values. 

Discrepancies are values that are some percentage above or below the Benford 

values; set Greater Than and Less Than parameters to define these percentages. 

• Mean: This pattern calculates a mean for a set of attribute values, and identifies 

individual values that are too far above or below the mean. Parameters include the 

amounts above and below the mean at which outliers are identified. 

To create a pattern: 

1. In the Model Logic panel, click on Actions > New Pattern, or on the New 

Pattern button. A dialog box appears.  

Note that you must first have selected at least one business object for the model 

with at least one attribute that provides data upon which patterns can operate (in 

the case of Benford and Mean patterns, numeric values). Otherwise, an error mes-

sage informs you that no pattern is associated with the selected business objects. 

2. Enter a name for the pattern in the Pattern field. 
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3. In the Pattern list box, select the pattern you want to use. (If you have not selected 

a business object appropriate for your patterns, however, this list box is empty.) 

4. Click on the green + icon; a row appears beneath the Object and Attribute 

headings. In the Object field of this row, select a business object; in the 

Attribute field, select an attribute belonging to the object. These fields display 

only objects and attributes upon which your pattern can operate. You may 

create additional rows to select additional attributes for the pattern to evaluate. 

You may also select a row and click on the red × icon to delete the row. 

5. Under the headings Parameter, Value, and Unit, one row appears for each 

parameter appropriate for the pattern you’ve selected. For each parameter row, 

enter a value in the Value field and select a unit of measurement to apply to that 

value — for example, 20 percent. 

Defining Model Results 

Select attributes for which the model, when it is run, will return values for each 

risky transaction it finds. 

A model may incorporate derived attributes. These are calculations performed by 

the model. Examples include a label applied to each group created by a filter that 

sets an attribute equal or similar to itself, or the sum, average, or count in a function 

filter that performs one of these calculations. Model results automatically include 

derived attributes, and you cannot remove them. 

You must actively select any other attribute to include it among the model results — 

even those cited in filters that define model logic.  

Be careful to choose attributes that reflect the level of detail you want to see in your 

results. For example, a model may use a function filter that calculates the a sum of 

invoice amounts for each supplier. The sum value, a derived attribute, is included 

automatically in the result set. 

Your model logic would have used the Invoice Amount attribute of the Payables 

business object. Even so, this attribute is not included automatically in the result set. 

If you choose to include it, results would contain a row for each invoice; this would 

be required to display the amount for each invoice. (Each row would also display 

the sum of its supplier's invoices.) If you do not, the results include many fewer 

rows: only one for each supplier, displaying the sum of that supplier's invoices. 

To define results: 

1. Scroll down to the Result Display panel in the Create Transaction Model page. 

(Or, collapse other panels by clicking on their ± toggle icons.) 

2. An Available box lists the business objects included in the model. For each, 

click on the ± toggle to reveal a list of the attributes that belong to the object. 

3. Select an attribute for which you want to see results (click on it), then click on 

the > button. The attribute moves to a Selected box. Repeat this process for all 

other attributes for which you want to see results. Alternatively, click on the >> 

button to move all attributes to the Selected box. 
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If you reconsider your choices, select attributes individually in the Selected box 

and click on the < button to return them to the Available box. Or, click on the 

<< button to return all attributes to the Available box. 

Saving the Model 

To save the model, click the Save button or the Save and Close button. Both are 

located near the upper right corner of the Create Transaction Model page. The Save 

option saves the model, but leaves its values on display for further editing, or for the 

generation of results. The Save and Close option saves the model but empties the 

Create Transaction Model page so that it is ready for the creation of a new model. 

Alternatively, you can click the Cancel button and respond to a confirmation prompt 

to restore the blank Create Transaction Model page without saving the model. 

Model-Design Principles 

As you create models, keep these guidelines in mind: 

• To improve performance, apply simple filters first in your risk logic.  

– A simple filter can be defined as one that places an attribute on the left side, 

and a fixed value on the right side, of a condition. For example: Payables 

Invoice.Payment Amount is greater than 1,000. Simple filters may also set 

date ranges or select transactions of a particular type (for example, paid 

invoices). A filter that uses the Similar condition is never a simple filter. 

– Use simple filters early in the risk logic to reduce the dataset size as much 

as you can without compromising results. For example, your first filter might 

select transactions completed after relatively recent date. The smaller the 

dataset, the better the model performs as it processes subsequent filters. 

– All objects in a model, when possible, should have a simple filter applied in 

the logic. This includes seeded business objects and user-defined objects. 

• If you use more than one filter to create a system-generated object, and if your 

model logic permits, place the filters one after another to create a single, combined 

object for subsequent use. For example, three successive filters might establish 

groups in each of which records have the same date, same invoice, and same 

amount. This increases efficiency and reusability. 

• Function filters, or filters that apply the “Related To” condition to user-defined 

objects, are best applied after simple filters. 

• If a filter uses the Similar condition, place it last, or as close to last as your 

model logic permits. 

• In the Result Display section of a model, select only the attributes you require. 

The number of attributes you select can impact performance, especially in user-

defined objects. 

• As you create a new model, consider a step process: add objects and filters one 

or two at a time, and generate results with each addition to verify model design. 

Also consider building the model against a small dataset; for example, use a 

date filter to remove all but a recent set of transactions. If you build an entire 
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model at once, and results are not as expected, problematic elements will be 

more difficult to identify as you troubleshoot. 

Viewing or Exporting Model Results 

From either the Manage Transaction Models page or the page in which you create 

or edit a model, you can view results from the most recent run of a model (if it has 

been run before), or run the model and view a new set of results. 

Before running a model, consider synchronizing data from the datasource against 

which the model will run; this would ensure that transaction data is up to date. Use 

either of the processes described in “Model-Data Synchronization” (page 11) or 

“Synchronizing Data” (page 5). 

No matter which page you use to display model results:  

• For a defined transaction model, the window displays a grid that devotes a row 

to each risky transaction. Each row includes values for the results attributes 

selected when the model was created or edited. 

• A pattern transaction model generates both graphic and tabular results. The 

graph presents a baseline identified by the pattern, and outliers to it. The table 

displays values that define data points in the graph. If the pattern analysis uses 

multiple attributes, the results page generates multiple result tabs, each of which 

presents a graph and a table related to one of the attributes used in the pattern 

analysis. 

If you hold the mouse cursor over a data point in a graph, a box displays the 

values defining that point. If you click on the data point, the grid refreshes to 

display only values for the data point you’ve selected. 

To open the results window from the page in which you create or edit a model, 

select one of three buttons, which appear in the title bar of the Model Logic panel: 

• Run: The model runs, and the page remains open. If the model had been run 

before, the new run overwrites the existing results (with no prompt to save or 

view them). 

• Run in Background: The model runs, but you may navigate to another GRC 

page and work there. Again, if the model had been run before, the new run 

overwrites the existing results. 

• View Existing Results: For a model that had been run before, the results 

window displays the results generated in the most recent run. 

To open the results window from the Manage Model page, do either of the following: 

• Locate the column labeled “View Results.” In it, the entry for each model 

contains a prompt (which also reads “View Results”) if the model has been run. 

(If not, the View Results cell is blank.) Click on the prompt (if one appears) for 

the model whose results you want to view. 

• In the Manage Models grid, click on the row for the model whose results you 

want to view. Then, in the menu bar, select Actions > View Results. 

If the model has not been evaluated previously, GRC simply runs it. If the 

model has been evaluated previously, a dialog box prompts you to decide 



 

 Creating and Managing Models 29 

whether to overwrite existing results. Select No to display the existing results. 

Select Yes to generate and display a new set of results. 

To view the status of a model run, open a Manage CCM Jobs page: select Contin-

uous Control Management under Continuous Monitoring in the GRC Navigator, then 

select Manage CCM Jobs under Control Administration in the Tasks list. (See “Jobs 

and Scheduling” in the Enterprise Governance, Risk and Compliance User Guide.) 

You can export model results to an Excel spreadsheet. To do so: 

1. In the results window, click on Actions > Export to Excel. 

2. A pop-up window offers you options to open or save the export file. Typically, 

click on its Save button and, in a Save As dialog, navigate to a folder in which 

you want to save the file. 
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3 

Creating and Managing Continuous Controls 

Typically, a continuous control defines risk and generates incidents — records of 

transactions that exceed the defined risk. A control may instead define a set of data 

that is incorporated into a user-defined object, which may then be used in other trans-

action models and controls as if it were a business object. 

Each control is based on a model, adopting the risk definition (filtering logic) devel-

oped for that source model. As you deploy the control, you add information needed 

for it to be applied. This includes a priority, whether the control is to generate inci-

dents or a dataset, and a datasource to which the control is applied. You also select 

perspective values, which determine the users who can work with the control itself 

and users who can resolve incidents. 

A Manage Controls home page presents a list of controls, with summary data about 

each. To open the page, select Continuous Control Management in the Navigator, then 

Manage Controls among the Continuous Control Management tasks. You can see 

only those controls to which your data roles give you access.  

You can create new controls from models, or edit existing controls. You can evaluate 

controls, import or export them, and run a report about them. For each control you 

select, GRC opens a distinct, tabbed page. To return to the Manage Controls page, 

close the control by clicking its Done button, or click on the Manage Controls tab. 

Creating Transaction Controls 

Because every control is based on a model, ensure that at least one transaction 

model exists before you attempt to create a transaction control. You may convert 

any number of transaction models into controls at once. If you create more than one, 

their processing logic, names, and descriptions remain distinct. Moreover, each con-

trol inherits an Allocated Analysis Time Per Filter setting from the model on which 

it is based. (For more on this setting, see “Choosing Whether to Limit Analysis Time” 

on page 12.) Other values are the same for all the controls you create at once. 

To create controls: 

1. In the Manage Controls home page, click on Actions > Create Transaction 

Control. 

2. A Create Control: Choose Model window opens. In an Available Models grid, 

select models you want to convert into controls: To select one, click on it. To 
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select a continuous set, click on the first, hold down the Shift key, and click on 

the last. To select a discontinuous set, hold down the Ctrl key as you click on 

models. A Model Logic panel displays the filters that define each model you 

select; the last model you select is the one whose filters remain on view. 

3. Click on the Next button. A Deploy Control: Define Control Details window 

replaces the Choose Model window. In it, set the following values, as described 

below: name and description; priority, status, and result type; datasource; per-

spective values and users who can investigate control incidents; and comments.  

You may click on a Back button, to return to the Choose Model window and 

revise your model selection. If so, when you return to the Define Control Details 

window, any values you have selected remain in force. 

4. When you are satisfied with all the selections you have made, click on the 

Submit button in the Define Control Details window. 

Naming and Describing Controls 

In the Define Control Details window, a Details grid displays a row for each model 

you selected. Each row contains the name and description of its model. You can 

accept these as the names and descriptions of the controls you are creating, or click 

in each Name and Description field to create new values. 

Setting Priority, Status, and Result Type 

In the Priority field, enter a value that expresses the importance of the controls you 

are creating in relation to others. The value must be a number. (Your company should 

establish a set of priority values and enforce consistent usage.) 

In the Status list box, select Active (the default) to use the controls you create, or 

Inactive to hold them in reserve. 

In the Result Type list box, select “Incident” if you intend for the controls to gener-

ate incidents, or “Dataset” if you intend for the controls to supply data to user-defined 

objects (see page 36). 

Selecting Datasources 

The models upon which you are basing the controls you create are already associ-

ated with datasources. You may retain those datasources, but if you choose to do so, 

you must actively select them as you create the controls. Or, you may select new 

datasources for the controls you are creating. 

1. In the Define Control Details window, click on the Map Datasource button. An 

Import Datasource Mapping grid opens, displaying one row for each datasource 

specified in the models upon which you are basing your controls. 

2. Double-click in the Mapped Datasources list box for one of the rows. A Select 

Datasource window opens; in it, select a datasource appropriate for the environ-

ment in which controls are to be applied. Click the OK button; the Import Data-

source Mapping grid reappears, with your selection occupying the Mapped 

Datasource field in the row in which you had been working. Repeat this step for 

all other rows. 
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In each row, a Datasources Used field displays the datasource associated with a 

source model. You may select this or another datasource in the Mapped Data-

sources field to apply to controls you are creating. 

3. Click on the OK button. The Map Datasources window closes, and your selec-

tions appear in the Datasource field of the Define Control Details window. 

Selecting Perspective Values and Result Investigators 

Two sets of perspective values apply to controls and the incidents they generate. 

Select them as you deploy the controls (see “Selecting Perspectives” on page 3). 

• “Perspectives” values apply to the controls themselves. These values determine 

who has access to the controls: users with job roles whose data security policies 

specify perspective values that match those selected here. A job role must also 

contain a duty role that grants privileges to work with controls.  

Users may have actively selected perspective values for the model a control is 

based on. The control does not inherit these values. It does inherit system per-

spective values selected automatically for the model. These reflect configuration 

decisions made for the model that also affect the control: whether it evaluates 

transaction or access risk, and the business objects and data sources that support 

its risk logic. (If you were to select a new data source for the control, you would 

indirectly modify its system perspective value for data source.)  

• “Result: Management Perspective Assignment” values apply to incidents 

generated by controls. To review these incidents, a user must have a job role 

with a data role whose perspective values match those selected here. The job 

role must also contain a duty role with an incident-review privilege. 

Once an incident is generated, a result investigator can modify its result-

perspective values, then reassign the incident to other investigators. Doing so 

has no effect on the configuration of the control itself. 

A Result Investigator field displays users who can review incidents generated by the 

controls you are deploying. They are eligible because their roles specify perspective 

values that match your result-perspective selections. You may: 

• Select one user to be responsible for reviewing incidents. Use a search option to 

filter potential result investigators by username, given name, or surname. 

• Select All Eligible Users. All potential investigators receive worklist 

notifications when a control generates incidents. Any of them can review a 

given incident. 

Writing Comments 

To add a comment to the controls: 

1. Click on the Add Comments button. An Add Comments dialog opens. 

2. In the Comments dialog, type the comment you want to add to the controls. 

3. Click on the Save button. The comment appears in the Comments panel of the 

Define Control Details window, together with the date, time, and your name. 
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Mass-Editing Controls 

You can modify certain settings for up to 1,000 existing controls at once. These set-

tings include priority, status, comments, perspective values, and result investigator. 

1. Select the controls you want to modify on the Manage Controls home page. You 

may work with your compete list of controls, or filter it and work with the filtered 

set. In either case, to select a continuous set of controls, click on the first, hold 

down the Shift key, and click on the last. To select a discontinuous set, hold 

down the Ctrl key as you click on controls. Or, click the upper left corner of the 

grid to select all controls in a complete or filtered list. However, do not select 

more than 1,000. 

2. Select Actions > Edit. An Edit Controls dialog opens. 

3. Modify any or all of the following: 

• In the Details panel, enter new values for priority (a number value), status 

(Active or Inactive), or comment. (The controls retain their original values 

for any of these fields you leave unedited.) 

• In each of the perspectives panels, select perspective values to be added to, or 

removed from, those already chosen for each control you are editing. Select 

the Add or Remove radio button, then move values to be added or removed 

from the Available Perspective Items list to the Selected Perspective Items 

list. As before, “Control Perspectives” apply to the controls you are editing, 

and “Result Management Perspectives” apply to incidents they generate. 

• Choose whether to select a result investigator (see page 33). By default, the 

field is blank; if you make no selection, each control retains the result inves-

tigator originally assigned to it. Or, a control defaults to All Eligible Users 

if its original investigator is invalidated by selections you’ve made for Result 

Management Perspectives. If you make a selection, it applies to all the con-

trols you are editing. Users available for selection are those whose data roles 

specify perspective values that are common to the controls you are editing. 

4. To complete the edits, click on the OK button. 

Viewing and Editing Individual Controls 

For each control, you can open a page in which you can view its full details. Or, you 

can open an edit version of that page, in which you can modify some configuration 

details, add comments, or revise perspective-value and result-investigator assignments. 

(Any number of pages, each devoted to a distinct control, may be open at once, but 

you must open them one at a time, to avoid triggering the mass-edit feature.) 

To open a control in view mode, click on its name in the Manage Controls home page. 

To open a control in edit mode, do either of the following: 

• Open a control in view mode, then click the Edit button in the view page. 

• In the Manage Controls home page, click in the row for the control you want to 

edit, and select Actions > Edit.  
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In each of these pages: 

• A Details panel displays the name, description, status, and priority of the con-

trol. You can modify those values in the edit-mode page; enter values in write-

enabled fields. This panel also displays information that cannot be edited, 

including the control type and result type; the datasources to which the control 

applies; dates on which it was created, last run, and last updated; a revision 

number; and whether the Allocated Analysis Time Per Filter feature (see page 

12) is enabled or disabled. 

• A Comments panel displays existing comments. When the page is in edit mode, 

you can add a comment as you would if you were creating a control. 

• A Control Perspectives panel displays perspective values currently assigned to 

the control. A Result Management Perspective Assignment panel displays per-

spective values assigned to control incidents, as well as the current result inves-

tigator. In the edit-mode page, you can modify perspective values (see page 3) 

and select a new result investigator (see page 33). 

• A Control Logic panel displays the filters, functions, or pattern that define the 

processing logic of the control, arranged in the AND/OR order in which they are 

analyzed. These elements cannot be edited. 

In the edit-mode page, click the Save button to save your modifications. In either 

the edit- or view-mode page, click the Done button to close the page. 

Running Controls 

You can cause GRC to analyze any selection of controls, returning incidents or 

compiling datasets for user-defined objects (according to the Result Type selected 

for each control).  

To begin, select the controls you want to run on the Manage Controls home page: 

You may work with your complete list of controls, or set search parameters to filter 

it, then work with the filtered list. In either case, you can: 

• Select one. Click on its row. 

• Select a continuous set. Click on the first, hold down the Shift key, and click on 

the last. 

• Select a discontinuous set. Hold down the Ctrl key as you click on controls. 

• Select all controls in a complete or filtered list. Click the upper left corner of the 

grid. 

Then, do either of the following: 

• Evaluate the selected controls once, immediately. Select Actions > Run, or click 

on the Run button. GRC displays status of the run at the base of the Manage 

Controls home page. 

• Create a schedule on which the selected controls run regularly. Select Actions > 

Schedule, or click on the Schedule button. A Schedule Parameter dialog opens; 

in it, enter values that set a name for the schedule, the date and time at which it 

starts, the regularity with which the controls are evaluated, and the date and 

time (if any) on which the schedule expires. Then click on the Schedule button. 
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Consider synchronizing data before evaluating controls, to ensure that transaction 

data is up to date. If you evaluate controls manually, you can synchronize data 

manually first. If you schedule control analysis, you can also create a coordinated 

schedule for data synchronization. In either case, you can synchronize data from the 

Manage Application Datasources page, which is opened from the Setup and Admin-

istration tasks. (See “Synchronizing Data” on page 5.) 

To view the status of a control run, open a Manage CCM Jobs page: select Con-

tinuous Control Management under Continuous Monitoring in the GRC Navigator, 

then select Manage CCM Jobs under Control Administration in the Tasks list. For 

more on this feature, see “Jobs and Scheduling” in the Enterprise Governance, Risk 

and Compliance User Guide. 

Contextual Reporting for Controls 

From the Manage Controls home page, you can run a Control Detail Extract Report. 

For each control, it provides the name, description and comments, type (Access or 

Transaction), priority, status (Active or Inactive), and number of pending results. It 

identifies users who created and most recently updated the control, and dates on which 

they did so. Finally, it displays the control’s processing logic. 

To run the report: 

1. Filter the list of controls to include only those about which you want the report 

to display information — for example, a list of controls at a particular priority. 

If you do not filter the list, the report includes information about all controls to 

which your roles give you access. (For information on filtering, see “Searching 

Among Records” in the GRC User Guide.) 

2. In the Report list box, select the Control Detail Extract Report. 

3. In the list box immediately to the right of the Report list box, click on the 

format in which you want to produce the report. The value csv produces a file 

designed for export to another application, such as a spreadsheet, for further 

manipulation. The value pdf produces a formatted report that can be viewed in 

Adobe Acrobat. 

4. Click on the Print button. An Information pop-up window opens, identifying a 

job number. Note the number, then close the window (click on its OK button). 

5. Using the Navigator, go to Tools > Setup and Administration > Manage Jobs. In 

the Manage Jobs page, locate the row displaying the job ID you noted in step 4. 

When its Message cell displays a Job Completed link, click on the link. 

6. A Job Detail window opens. In it, click on the Item Results link. 

7. A file-download window offers you options to open or save the report. The 

precise behavior of this window depends on the web browser you use. In gen-

eral, if you choose to save, select the Save option. In a distinct save-as dialog, 

navigate to the folder in which you want to save the file.  

8. Close the Job Detail window (click on its OK button). 



 

 Creating and Managing Continuous Controls 37 

Managing User-Defined Objects 

A user-defined object (UDO) is a set of data returned by a CCM continuous control 

that is used as if it were a business object. Each column in the results returned by one 

of these specially configured controls serves as an attribute of the object generated 

from the control. 

Only a transaction model or control can cite a user-defined object. However, either 

an access or a transaction control can serve as the basis of a user-defined object. 

A control can generate incidents, or it can provide data to a user-defined object, but 

it cannot do both. The user who creates a control determines which purpose it serves 

by selecting an appropriate value for a Result Type field — “Incident” for a control 

that generates incidents, or “Dataset” for a control that supplies data to a user-

defined object. 

Creating UDOs 

To create a user-defined object: 

1. Create a model (page 11) from which you will develop a control, from which 

you will in turn generate a user-defined object. 

2. Turn that model into a control (page 31), being sure to select “Dataset” as its 

result type. 

3. Open the Manage User Defined Objects page (Navigator > Continuous Control 

Management > Manage User Defined Objects). 

4. Select Actions > Create from Control. 

5. A Create from Control window opens. Enter appropriate values in its fields: 

• Based On Control: Select the control you created in step 2. (This field lists 

all controls for which the result type is “Dataset.”) 

• Business Object Name: Create a name for the user-defined object (which 

need not be the same as the control from which the object is generated). 

• Description: Optionally enter a brief description of the object. 

• Domain: Select a value that characterizes the object. 

• Category: Select a value: Transaction is appropriate for an object in which 

data is updated frequently. Operational and Configuration are appropriate 

for master-data and setup records that change infrequently. 

• Status: Select Active or Inactive. 

6. Select the OK button. 

You must also run the control (see page 35). You may do so either before or after 

you enter values in the Create from Control window. However, you must do so 

before using the user-defined object in a transaction model or control; otherwise no 

results will be generated. Each time the control is run, the data available to the user-

defined object is refreshed. 
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When it is created, a user-defined object has no join relationship to any other object. 

As you create filters in transaction models, you can use a “Related To” condition to 

create a join relationship between a user-defined object and another object. 

Editing and Deleting UDOs 

The Manage User Defined Objects page displays records of all user-defined objects 

in a “Search Results” grid. You may select an object, then either edit or delete it.  

• Select Actions > Edit to open a popup window in which you can modify the 

description, domain, category, and status values.  

• Select Action > Delete, and then click OK in a confirmation message, to delete 

an object. However, you can delete an object only if it is not used in any con-

trol. (A Used in Control column indicates whether this is the case.) 

UDO Best Practices 

Follow these performance guidelines: 

• Limit the amount of data returned by UDOs, or by models or controls that 

consume UDOs, to 100,000 or fewer rows. Add filters during model-logic 

definition to ensure acceptable performance. 

• The nesting of UDOs is not recommended. “Nesting” means that the logic of a 

control that is the basis for a UDO also contains a UDO. 

• The smaller the number of business objects to which a UDO needs to be joined, 

the better the performance. (For example, you might relate a UDO to only one 

or two business objects.) 

• When applying the “Related To” (join) filter condition, use the most unique (or 

primary) attribute for better logic processing. 

• For reusability, keep UDOs as generic as possible. However, do not allow this 

approach to result in a data set larger than the 100,000-row limit. 

• Be sure to select only key attributes in the model used for a UDO, such as those 

required to establish join relationships, to create custom attributes, or to be 

returned as results. The number of selected attributes can impact performance. 
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4 

Resolving Incidents 

The evaluation of transaction controls generates “incidents,” each the record of a 

transaction that exceeds the risk defined by a control. Each consists of values for 

attributes that were selected for a model from which the control was developed.  

A Manage Results home page presents incidents belonging to the person currently 

logged on to GRC — for your purposes, you. Incidents may belong to you because 

controls that generate them identify you as a result investigator, or because other 

investigators assigned them to you. To open the page, select Result Management in the 

Navigator, then Manage Incident Results among the Result Management tasks. 

From the Manage Results home page, you may navigate to other pages that show 

detailed records of individual incidents. To return from those pages to the Manage 

Results home page, click on the Manage Results tab. 

The actual resolution of incidents occurs outside of GRC. For example, you may 

determine that a purchase order should be canceled if a transaction control shows 

that it is suspect; that action would be completed in the business-management appli-

cation to which it applies. In the GRC Manage Results pages, you can: 

• Review the details of incidents assigned to you. 

• Set the status of those incidents to reflect whether anything should be, or has 

been, done about them. 

• Reassign them to other incident reviewers. 

Incident Status and State 

Initially, incidents appear in the Manage Results home page at an Assigned status, 

which means that result investigators have been designated to address them. If you 

are one of the result investigators, you can update an Assigned incident to any of the 

following statuses. 

• Accepted, which means you have determined that nothing need be done to 

resolve the incident. 

• Remediation, which means you have decided that some action must be taken in 

the business-management application to resolve the incident. 
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• Resolved, which means you have confirmed that the remedial action has been 

carried out in the business-management application. 

GRC may set other statuses:  

• Control Inactive means that an incident is no longer of concern because the con-

trol that generated it has been inactivated.  

• Authorized and Closed apply exclusively to incidents generated by AACG con-

trols (See the Application Access Controls Governor User Guide.) 

An incident has not only status, but also one of three states: In Investigation, 

Approved, or Closed. You cannot directly set the state of an incident. If you change 

its status, however, you have the option either to save or submit the change. A sub-

mission can cause the incident state to change. A save cannot. If you submit status 

changes: 

• If the status of an incident is Assigned or Remediation, its state is In 

Investigation. 

• If the status of an incident is Accepted or Resolved, its state is Approved. 

However, because of the distinction between saving and submitting a status change, 

this is not always true. Two examples: 

• An incident is at the Remediation status and In Investigation state. You update 

status from Remediation to Resolved. If you save the incident, its state remains In 

Investigation. The state advances to Approved only if you submit the incident. 

• An incident is at the Resolved status and Approved state, but you decide further 

action is needed, and so change its status to Remediation. If you submit the 

change, the incident state changes to In Investigation. If you save the change, 

the state remains Approved. 

If the status of an incident is Authorized, its state is Approved; if its status is Closed 

or Control Inactive, its state is Closed. 

State matters in part because by default result pages show pending results, which are 

defined as those at the In Investigation state. State matters also because each user’s 

data roles specify states at which he or she may access data. Use standard search 

features to cause result pages to display incidents at other states, if your roles give 

access to data at those states. 

Viewing Controls or Incidents in Summary 

To review, edit, or assign status to incidents, open the Manage Results home page: 

select Manage Incident Results from the Result Management tasks available from the 

Navigator. 

From the Manage Results home page, you may navigate to other pages, which show 

detailed records of individual incidents (see page 42). To return from those pages to 

the Manage Results home page, click on the Manage Results tab. 

You can set the Manage Results home page to display either a list of controls that 

have generated incidents, or a list of incidents generated by those controls. In the  
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control list, each control links to a list of the incidents only it has generated. From 

any list of incidents, you can open pages that provide details of individual incidents. 

• For a list of controls, select Control Summary in the View By list box. 

• For a general list of incidents, select Incident Results in the View By list box. 

For a list of incidents generated by a specific control, click on its Pending Result 

Count in the Control Summary list. 

You can hide or restore the columns that appear in the grids displaying controls or 

incidents; right-click in the header row of the grid to open a checklist of columns. 

Those available for incidents include the following: 

• Incident Information: For a transaction incident, this is the value of the first 

attribute among those selected to characterize the suspect transaction. (These 

values were selected during configuration of the model that served as the basis 

of the control that generated the incident.) 

• Group and Grouping Value fields: For transaction incidents, results vary. 

– If a transaction control uses a filter in which the Equals condition sets an 

attribute of a business object equal to itself, the Group field reports the 

business object and attribute cited in the control, and the Grouping Value 

field reports the common value of this attribute.  

– If a transaction control uses a filter to find transactions with similar values 

for a specified attribute, the Group field displays the word Similar and the 

specified attribute, and the Grouping Value field displays the value of that 

attribute for a given incident.  

– If a transaction control uses a function to calculate a value for a specified 

attribute across a group of transactions, the Group field identifies the calcu-

lation (count, sum, or average) and the specified attribute, and the Grouping 

Value field displays the calculated value for a given incident.  

– If a transaction control uses a pattern to create a baseline value, the Group 

field displays the pattern type and the attribute upon which the pattern is 

based, and the Grouping Value field displays the baseline value. 

Mass-Editing Incidents 

You can set status for up to 1,000 of incidents, or write comments for them, all at 

once. To do so, first choose the incidents with which you want to work: 

1. Generate a list of incidents in the Manage Results home page.  

2. Select from the list. You may work with your complete list of incidents or set 

search parameters to filter it, then work with the filtered list. In either case, you 

can: 

• Select a continuous set. Click on the first, hold down the Shift key, and 

click on the last.  

• Select a discontinuous set. Hold down the Ctrl key as you click on incidents. 

• Select all incidents in a complete or filtered list. Click the upper left corner 

of the grid. However, do not select more than 1,000. 
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3. Select Actions > Edit. A Mass Update dialog opens. 

4. Do any of the following: 

• Select the status you want to assign to the selected incident in the Status list 

of values. (See page 39 for a discussion of status definitions.) 

• Write a comment in the Comments field. 

• Attach files to the incidents (see page 6). For a mass edit, you can attach 

only URLs. 

5. Click the Save, Save and Close, or Submit button. (Remember that a submission 

can alter the state of an incident, but a save cannot. See page 40.) 

Because the Manage Results home page displays pending incidents by default, inci-

dents disappear from its list if you select a status other than Assigned or Remedia-

tion, and submit the change. You can, however, search for incidents at other statuses. 

Viewing and Editing Individual Incidents 

For each incident, you can open a page in which you can view its full details. Or, 

you can open an edit version of that page, in which you can set the incident’s status, 

attach files, add comments, and reassign the incident. (Any number of pages, each 

devoted to a distinct incident, may be open at once, but you must open them one at a 

time, to avoid triggering the mass-edit feature.) 

To open an incident in view mode, generate a list of incidents in the Manage Results 

home page (see “Viewing Controls or Incidents in Summary” on page 40), then 

click on the Result ID value for the incident you want to open. 

To open an incident in edit mode, do either of the following: 

• Open an incident in view mode, then select Actions > Edit Definition in the 

view page for that incident. 

• Generate a list of incidents in the Manage Results home page, click in the row 

for the incident you want to edit, and select Actions > Edit.  

Each view or edit page includes a Details panel, which displays the name, descrip-

tion, and priority of the control that generated the incident; the current incident sta-

tus and state; dates on which the control was last run and on which the incident was 

created and last updated; datasources on which the incident exists; and other details. 

Below the Details panel, a set of tabbed panels provides additional information: 

• Result Details defines the incident in question. The grid displays values for all 

attributes selected to characterize the suspect transaction. (These values were 

selected during configuration of the model that served as the basis of the control 

that generated the incident.) 

• Perspectives shows the perspective values and result investigators currently 

assigned to the incident. (Initially, these are determined by Results Management 

Perspective Assignment values selected for the control that generated the inci-

dent.) You can modify these values (see “Assigning Incidents,” page 43). 

• Comments displays the comments currently written for the incident, and enables 

you to create new comments.  
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• Relationship Assignment lists associations currently configured between the 

incident and processes, other base objects, risks, or controls in the Financial 

Governance module or custom EGRCM modules. You can modify these values 

(see “Assigning Relationships,” page 44). 

To set status for the incident, open it in edit mode and select a new value in the 

Status LOV of the Details panel. (See “Incident Status and State,” page 39.) Click 

the Save button or the Submit button. (Remember that a submission can alter the 

state of an incident, but a save cannot.) In the details panel, you can also attach files 

to the incident (see page 6). 

To create a new comment, open the incident in edit mode, click the comments, tab, 

and click the Add Comments button. An Add Comments pop-up window opens; 

type your comment and click the OK button. Then save the incident. 

Assigning Incidents 

If you are the result investigator for an incident, you can assign the incident to 

another user. You can reassign any number of incidents at once from the Manage 

Results home page. Or, you can reassign an individual incident from its edit page.  

Because eligible investigators are users whose roles specify perspective values that 

match those assigned to an incident, reassigning the incident may involve resetting 

the perspective values configured for the incident. Or, you may retain the perspec-

tive values for an incident, and modify only the result-investigator selection.  

To reassign incidents from the Manage Results home page: 

1. Generate a list of incidents in the Manage Results home page (see page 40). 

2. Select the incidents you want to reassign: To select a single incident, click on its 

row. To select a continuous set, click on the first, hold down the Shift key, and 

click on the last. To select a discontinuous set, hold the Ctrl key as you click on 

incidents. Or, make no selection to reassign all in a complete or filtered list of 

incidents. (You cannot reassign more than 1,000 incidents at a time.) 

3. Click on the Assign button. A Perspective Assignment pop-up window opens. 

4. IF you intend to modify perspective values, select values to be added to, or 

removed from, those already chosen for each incident you are reassigning. (See 

“Selecting Perspectives,” page 3.) Select the Add or Remove radio button, then 

move the values to be added or removed from the Available Perspective Items 

list to the Selected Perspective Items list.  

If you are editing incidents with distinct sets of perspective values, you add or 

remove the same values to or from each set, but you add or remove only those 

values, and the sets remain distinct. 

5. In the Result Investigator field of the Worklist Assignment box, select a result 

investigator. 

• Select All Eligible Users to permit incident review by any user whose job 

roles specify data roles that specify perspective values that match those 

chosen for the incidents.  
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• Select Search to appoint a single user for incident review. A Search and 

Select Investigator dialog opens. In it, enter text strings to match any 

combination of username, given name, and surname. (You can use the 

percent sign as a wild-card character.) Then select the user you want. 

By default, the Result Investigator field is blank. If you make no selection, each 

incident either retains the result investigator originally assigned to it, or defaults 

to All Eligible Users if its original investigator is invalidated by new perspective 

selections. If you make a selection, it applies to all the incidents you are editing. 

6. Click the Submit button 

To reassign an incident from its edit page: 

1. Open the edit page for the incident (see page 42). Select the Perspectives tab. 

2. If you intend to modify perspective values, select new values for the incident. 

(See “Selecting Perspectives,” page 3.) From the incident’s edit page, you edit 

perspective values; those remaining in the Selected Perspectives list are all the 

values that apply to the incident. 

3. Select a result investigator in the Result Investigator field of the Worklist Assign-

ment box. As before, you can select all users whose roles specify perspective 

values that match those selected for the incident, or any one of those users. 

4. Click the Save button or the Submit button. (Remember that a submission can 

alter the state of an incident, but a save cannot. See page 40.) 

In either case, the Result Investigator selection determines the distribution of 

worklists to users. Each worklist is a record of pending incidents generated by a sin-

gle control, but includes only those assigned to the worklist recipient. However, any 

user with perspective-based access to a control's incidents can see all those incidents 

in Results management pages — even those for which he is not selected in the 

Result Investigator field. 

Assigning Relationships 

You can establish relationships between incidents in the CCM module and objects 

in EGRCM modules. Incidents may be related to processes, other base objects, risks, 

or controls, which may exist in the Financial Governance module or any custom 

module. Once a relationship is created, the incident is listed both in the CCM Manage 

Results page and in a Results tab of the Manage page for the EGRCM object to which 

the incident is related. 

From the Manage Results page, you can create relationships for any number of 

incidents at once. Or, from the edit page for an individual incident, you can create 

relationships for that incident. 

To create relationships from the Manage Results home page: 

1. Generate a list of incidents in the Manage Results home page (see page 40). 

2. Select a set of incidents. To select a single incident, click on its row. To select a 

continuous set, click on the first, hold down the Shift key, and click on the last. 

To select a discontinuous set, hold the Ctrl key as you click on incidents. Or, 
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make no selection to modify relationships for all in a complete or filtered list of 

incidents. (You cannot reassign more than 1,000 incidents at a time.) 

3. Click on the Assign button. An Assignment pop-up window opens; select its 

Relationship Assignment tab. 

4. Select the Add radio button to add objects to those already chosen for each of 

the incidents you’ve selected. Or select the Remove radio button to remove 

objects from those already chosen. If you are editing incidents with distinct sets 

of relationships, you add or remove the same objects to or from each set, but 

you add or remove only those objects, and the sets remain distinct. 

5. Select Actions > Add, or click the green + button. A Search and Select window 

opens. 

6. In a Module field, select an EGRCM module. In an Object Type field, select a 

type of object within that module. Click the OK button. The Search and Select 

window expands to list objects of the type, and within the module, you specified. 

7. In that list, select objects with which you want to work. You can search for 

objects. Again, you may use the Ctrl or Shift key to select sets of objects, or 

make no selection to accept all in a complete or filtered list. 

8. Click the OK button. Objects you’ve selected then appear in the Related Objects 

grid of the Relationship Assignment window. 

9. If you determine you’ve added objects to the Related Objects grid erroneously, 

remove them: Select them and select Actions > Remove, or click the red × button. 

10. Click on the Submit button. 

To configure relationships from the edit page for an incident: 

1. Open the edit page for an incident, and select the Relationship Assignment tab. 

2. Select Actions > Add, or click the green + button. A Search and Select window 

opens. 

3. In a Module field, select an EGRCM module. In an Object Type field, select a 

type of object within that module. Click the OK button. The Search and Select 

window expands to list objects of the type, and within the module, you specified. 

4. In that list, select objects with which you want to work. You can search for 

objects. You may use the Ctrl or Shift key to select sets of objects, or make no 

selection to accept all in a complete or filtered list. 

5. Click the OK button. Objects you’ve selected then appear in the Related Objects 

grid of the Relationship Assignment window. 

6. Click the Save button or the Submit button. (Remember that a submission can 

alter the state of an incident, but a save cannot. See page 40.) 

Contextual Reporting for Incident Results 

When you select Control Summary in the View By list box of the Manage Results 

home page, you can generate a Result by Control Summary Extract Report. It lists 

access and transaction controls that have generated pending incidents, and provides 

information about each control. 
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When you select Incident Results in the View By list box of the Manage Results 

home page, you can generate the following transaction reports: 

• Result Summary Extract Report lists incidents generated by access and transac-

tion controls, providing summary details for each. 

• Transaction Incident Details Extract Report lists incidents generated by a 

transaction control. It provides not only the information that would be included 

in the Result Summary Extract Report, but also values for all attributes selected 

to characterize suspect transactions. These attributes vary from one control to 

another, so each run of the report must focus on a single control. 

To run a report: 

1. Generate a list of controls or a list of incidents in the Manage Results home 

page (see page 40). 

2. Filter the list to include only the controls or incidents about which you want the 

report to display information — for example, a list of controls at a particular 

priority or a list of incidents at a particular status. If you do not filter the list, the 

report contains either all controls or all pending incidents to which your roles 

give you access. (For information on filtering, see “Searching Among Records” 

in the GRC User Guide.) 

Some incident reports are specific to access or transaction incidents (or con-

trols), and others are general. GRC automatically filters by type as needed: An 

access-specific report includes information only about access controls or inci-

dents, a transaction-specific report includes information only about transaction 

controls or incidents, and a general report includes information about both. 

3. In the Report list box, click on the report you want to run. 

4. In the list box immediately to the right of the Report list box, click on the 

format in which you want to produce the report. If the report has the word 

Extract in its name, you can select only the value csv; this produces a file 

designed for export to another application, such as a spreadsheet, for further 

manipulation. For all other reports, you may choose csv or pdf; the latter 

produces a formatted report that can be viewed in Adobe Acrobat. 

5. Click on the Print button. An Information pop-up window opens, identifying a 

job number. Note the number, then close the window (click on its OK button). 

6. Using the Navigator, go to Tools > Setup and Administration > Manage Jobs. In 

the Manage Jobs page, locate the row displaying the job ID you noted in step 5. 

When its Message cell displays a Job Completed link, click on the link. 

7. A Job Detail window opens. In it, click on the Item Results link. 

8. A file-download window offers you options to open or save the report. The 

precise behavior of this window depends on the web browser you use. In gen-

eral, if you choose to save, select the Save option. In a distinct save-as dialog, 

navigate to the folder in which you want to save the file.  

9. Close the Job Detail window (click on its OK button). 
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